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Some Important Terminology

As I go through, I’ll be using some words that may not be intuitive.  If I use the word

Quadrant, it refers to one of the 4 sections of the program, the Map areas being the

largest.  Within each quadrant, I’ll frequently use the word Pane or Tab.  This refers to the

different information sheets available within each Quadrant.  

Quadrants:

Tabs



Setting Up a New Game

From the Game menu, select New Game.  The New 

Game dialogue will pop up, enter your relevant 

information.  Check the New XML box if applicable, 

then click Okay.

Nation Number allows JOverseer to know where to 

centre the map when you open the game.



You’ll notice the Import Dir feature has it’s own 

icon on the main toolbar.

Keep your files together, both pdf and xml’s.

DO NOT IMPORT PDF’s ALONE!

You will get errors.   You can import XML’s

alone, but you’ll lose many information

features available from the parsed text, etc.

See the Import Game Dir Tree option.  This

will allow you to import as many turns as you

have for a game already in progress.  As 

long as your folders are named in a similar 

manner as mine are to the right.  Select this

option and you would highlight the Turns

folder in my example to import the entire 

game up to Turn 11~!  Otherwise, the 

Import Dir option requires you that point 

directly to the folder that contains your turn.

Happily, JOverseer remembers your last turn 

folder for each game, so you won’t have to 

start at My Documents and search every 

turn!



Every Time you Import a Directory, you’ll be asked if you want to adjust Allegiances.  

The program will stop asking when all neutrals have been aligned.

Here I’m setting Turn 0 up for a Grudge 

Game.  Not a Standard WC, and it didn’t 

work out very well for the DS, so I don’t 

recommend this set up.. ☺



Direct JOverseer standard dialogue 

to your Turn 0 folder and select 

Open.

Once you Open, the Import Files 

dialogue will open.  Let it run, it’s 

quite quick, then you can select OK 

when it’s finished.  If there are any 

error messages, they’ll be displayed 

at this point.



Congratulations!  You are ready to manage your 

MEPBM experience like never before!

From this point on, I’ll review some of the basic features showing some of the 

information available, order creation/checking/export, map drawing and exporting the 

map file.



Current Hex View

Is where you’ll be looking easily 50% or more of the time.  Population Centre information, 

Armies, Characters, Encounters, Nation Messages, Movement tables, etc.  It’s worth 

exploring all the features of this area under the drop downs and arrows available.  Take 

some time to get acquainted with what is provided for you here.



These “Show” features are amongst the coolest

you’ll come across!  I’ll choose to show the range

of Earnil’s army and also the Character Move

Range on Map on the next page.



Earnil’s army range is represented by the red numbers on each hex – the Fed movement 

point at which the army will get you there.  Note, there is also the Toggle Fed Property 

feature that allows you to show the movement after picking up food (340 order), or vice versa.

The Character Range is shown by the hexes outlined in red 12 from the hex selected.  Long 

Stride, Far Stride, etc, also available.

Okay, we’re actually getting ahead of ourselves here, not surprising, most people want to just 

dive right in and hack around.  Let’s find what one might imagine is an extremely important 

toolbar button for when we’re filling the map up with overlaying chaotic movements, ranges,

etc.....

Also found in the Tools Menu, the Clear Map Items

button will rid our tired eyes of all these drawn ranges

and Highlighted items we haven’t covered, but as

per the menu on the left, are other options you can

guess we can draw on the map!  Again, we’re getting

too far ahead of ourselves.



Map Features

There are lots of little dots and items on the map that direct you to Current Hex View.             

Characters and Icons are pretty self explanatory.  But there are lots of other items and dots you

see around.  See below.  In the top left, you see what looks like a Character icon, it is – but it’s

a Dragon!  At the bottom, the red dot will always represent a Nation Message regarding that

hex.

For All Combats, Challenges, and Encounters,

You’ll get the option to Show Narration.  This is

the actual text parsed from the pdf.

For the record, this is a 1 week turnaround Grudge Game, so by the time any of our opposition reads this, Thranduil with Throkmaw will

have already cleared out Morannon for a Woodmen army with War Machines to burn the place... ;)



The Grey character icons are those that the program knows about but will not assume

to know the nation – because it hasn’t been reported.  In this case, the Blue dot is an

LA/LAT spell showing an artefact.  This is how we know Urzahil is here.

Here, you can see our ScoChar

Order has identified the nation of

the characters, so their character

icons on the map are showing

the appropriate colours.  Unlike

Palantir, all characters and up to

5 Armies per allegiance actually

appear here – more complete info.



Here also, you’ll notice that a

Recon or Palantir has discovered

the Army Commander and the

approximate number of troops.

In Current Hex View, any orders

saved with the game file will

show here.  You’ll also see how

company members are noted, so

you won’t forget to move or Join

Company if necessary!



The Pink icon as illustrated below reflects a

Combat occurring in this hex, with the related

Narration parsed from the pdf for your reading

pleasure.

See how the Harad characters Ilifaks is listed

as a C40 from “collected info”.  That reflects

his Title as shown due to him leading an Army,

or similarly from a ScoChar order.  Challenge

Rank is also included (“Cr”) as best assumed

from the information available.

Note:  this information is inferred from the Character

Title as per the tables in the rule book, also included

in the Info Pane of JOverseer

If you can imagine this icon is a horse’s head, then you would understand why it

represents an All Cavalry army.



The Crossed Out areas represent hexes that are neither

on your map nor have an uploaded population centre on

them.  This very clearly will identify the “off map” hexes

once all your files are loaded.

Everything that is known is colour coded (these colours can be adjusted in your

preferences).  So the Grey icons, dots, pops, etc, are therefore Unknown.  From the

map below, you see we have Unknown camps on crossed out areas that are not on

our turn files.  Current Hex View for the selected hex (outlined in Yellow) tells the

tale – we did a Recon or Palantir that displayed this unknown camp on turn 8.

I’ve been working with this program exclusively for months, and have rigorously tested much,

but only in the writing of this document did I know, for example, that ‘Pink’ dots were Combats.

There is so much information displayed that one mustn’t feel bad for not knowing everything,

but providing Current Hex View is one of your default Panes displaying, a quick scan of your 

map and curious Clicks on hexes where you do see Dots and Icons will allow you to get to

know the information capabilities of the program.

Now we’ll move into actually using the program to write, draw, check, and export our orders.



Here I’m doing orders for the Riders of Rohan.  I’ve selected hex 2321 and am checking the 

orders for the characters there.  You’ll see Current Hex View has the orders highlighted, I’m

showing the Orders pane at the bottom and have selected one of Brand’s orders in the

Order Editor pane (bottom right).  These are more detailed on the next page.

Orders
Current Hex View

Order EditorOrders Pane



It’s possible to enter orders in the Orders pane as

illustrated above, excepting you will have to tab from

field to field and ensure you get the parameters in the

correct order.  Or, you can use the Order Editor as

below.  Simply click on the pencil icon beside the

order and the Order Editor opens up.

You can type the Order Number until it appears, or

choose from a drop down.  Orders that the character

does not have the skill to perform will not be allowed.

Once the order is selected, the Parameters will 

present themselves.  Here, a 325 order will provide a 

drop down of products to select from and a box to 

enter the percentage

In the Order Editor, there is Tab capability, it really 

takes getting used to, but is quite easy and intuitive.



Order Checker

Choose Run Order checker from the Game menu,

Select your nation and away you go.

This is the program you might already know simply

embedded into JOverseer.  The creator of JOverseer

cannot support this software add-on.  It’s included here

as it’s an extremely popular program and therefore fits

into an “everything” type of program.



Exporting Orders

Providing you have the ability to connect to the

Internet, you can send your orders directly via the

meturn.com protocol.  Or, you can simply create the

auto-order file and save it to email/upload later.

Choose your nation, the Version might require updating,

but if you’ve been saving your file properly, it will be

correct.  Click Generate, then either Send or Save.
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I’ll illustrate the 7 step process

to Export (Save then Send)

your orders.

After you’ve Saved them, you’ll

Send them, then the program

wants you to Save your game.

1) it’s the prudent thing to do

2) it allows JOverseer to know

which order file Version you are

on so the next update you have

to send, it will ensure your file

is named properly.
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Generating an Order Report

Providing you want to share your orders with your allies,

select Generate Order Report from the Game Menu.

Select your nation and click Generate, and your orders

will display in text format.

Unfortunately, you have to use your mouse to Highlight the

orders then use Ctrl-C to Copy them to the Clipboard in

order to Paste them into a text file or email.  I’ve been

nagging the developer about this one..!

You can continue by choosing another nation (multi

nation games) and click Generate again....repeat.



The Way the Tabs Work

Every tab shows information.  All column headers can be sorted on by double clicking.  Any

buttons provide further filtering options.  Most of the time, you’ll notice how the Defaults are

for Current Turn.  I’ll use the Characters tab to illustrate:

End of the Introduction!

You’ve now Created a New Game, Loaded a turn’s worth of information, checked out the map,

created orders for your characters, checked them with Order Checker, Exported them directly

to meturn.com, and then copy-pasted a text version of them to distribute to your nosy allies.

Congratulations!

But you’ve been able to do that before you found JOverseer...so why did you bother?  Sure,

it might be handy to have all that in a single application, and since it’s free you can’t really

complain...but why all the fuss?

I’ll get into a lot of the fuss in the next pages.  There is a lot of fuss for good reason, frankly,

and there really isn’t any easy way to get into it all without dragging you through hundreds of

pages of this...  I’ll take you through a few items to illustrate, and leave you to explore the rest

of the program on your own.

Here I’ve selected the Chars(adv) tab (Advanced).  Notice the Defaults of All, Current Turn,

Not Dead & Dead (yes, Dead characters appear – on Current Hex View too).  Use the buttons

to Filter and then double click on any column header to Sort.  I’ll choose to sort my Riders of 

Rohan characters by Emissary skill on the next page to figure out where these guys are...



Here that is.  Another most excellent feature that is consistent throughout the product, is that

I can now Double Click on any of those records and the map will bring me to that hex.  If I

double click on Edmonton, my best emissary currently, the map would centre on his hex,

highlight it in Yellow, and Current Hex View would show that hex’s information.

Here I’ve selected the LA’s tab.  Similarly, Double Clicking on the LAT by Galadriel brings me

right to that hex, and shows it in Current Hex View.  From which I can do all sorts of analysis

see who else is there, etc.



Here I’m showing the Nat Msgs pane.  I can sort on Messages and very quickly find the kinds

of Rumours I’m looking for without having to read through them in the order they were loaded

into the program.

Again, this is how all the information panes work.  Filtering, Sorting, and double-clicking, where

applicable, to show the relevant hex on the map, is consistent throughout.  Once you get used

to the sheer volume of information that’s out there, you’ll realize the power you have to better

understand what’s going on across the whole map and how information can enable you to make

better decisions, improve coordination and planning, etc.



Drag and Drop

This is one of many of “the best” items in JOverseer in regards to issuing better orders~!

You can Drag and Drop Characters, Artefacts, and Hexes from the map into your order 

parameter fields.  Here I have Pelendur wanting to get rid of all those Command arties

before he get’s whacked and loses them all.

Instead of relying on typing, I can issue the

360 and then simply click on the artefact, hold

the mouse button, and drag it to the parameter

field, then release.  Poof, no more typos!  This

is most helpful when your ally names company

commanders with apostrophes and other

whacky names – no more missed ID’s!  It works

the same with the map – issue the 810, then

after you Show Character Move Range on Map

form the Hex Info drop down, you can simply

Click on any hex, hold the mouse

button, and drag/drop it in your 810

parameter field in Order Editor.  No

more transposed movements~!

Current Hex View Feature:

The Blue arrow beside the character will

reveal all Spells and Artefacts for that

character.  They’re hidden by default, but

a simply click will reveal all the information

showing in the pdf.

Check out all the drop down arrows

throughout the program to see what’s

available.  One I use a lot to review is

the Show Order Results option that

shows the text for that character’s last

turn straight from the pdf.



Draw Orders

Here is my absolute favourite  item on this program~!  You can draw your orders~!  Character

movement appears as a black line, Army movement is hex by hex (with the movement points

required per) red line.  Transport orders show in Green.  Recons/Palantirs and ScoArea orders

show a blue outline around the hexes you expect to view.  Take a look~!

No more duplicated emissary movements!  No more navies sailing over mountains!  And also,

if you make a mistake, the program will tell you!  Here I’ve added a hex to an army move, see

the colour change?  And the character movement from 2321 to 3616 I’ve extended to more 

than 12 hexes.



Draw Names on Orders

It get’s better!  From the Map Options pane, click Draw Names on Orders and presto, you get

the above!  This function requires some qualifications – for example, if a character is not

moving that turn, the program will ask where his end location for a Recon order will be.  But

a Palantir order requires the Hex# as a parameter, so JOverseer doesn’t bug you.  Also, newly

created armies will ask you if they’re Fed or Cavalry.

Now, this can be pretty tough to handle.  Here, I’ve drawn orders for ALL nations.  This is not

necessary – you can draw orders 1 at a time, nation by nation, or all at once.  Next page, I’ll

show you how...



Click the check boxes to draw a single order.

In the Orders Pane, highlight an

order and you get this menu.

Note, if you Filter the Orders Pane

by Nation, you can Set Draw On

for All Orders for only that nation!

And finally, from the Tools menu, you can select

Toggle Draw Orders and the program will draw all

orders it has saved.

Note the other functions here in tools!  Please

explore, I won’t go through them all in this guide,

although I may note a couple.  One I’ll mention right

now is the Export Map Image option – this will export

the map exactly as it’s displaying for you at the time

you select this option, so if you’ve drawn all your

orders, you’ll create a jpg with them all showing.

You’ll recall I had drawn order for 12 nations – mine and

all of my allies also.  How did I get all those orders

saved in the program.....?



Importing Orders

You can import Automagic/MEOW order files directly into 

JOverseer.  You can also import text orders, like the order 

report you can generate from this program.  Automagic

and MEOW, for example, create the same kinds of order 

reports – Copy them to the clipboard from your ally’s email 

and paste them directly into JOverseer.  Then, you can 

draw them too!

This is exceptionally handy in Team games where 

different players are responsible for different areas of the 

game – i.e., drawing all the orders can quickly show you 

where more than one Character Move Order lands in the 

same Misty mountain hex during the early camp

game!

Simply follow the instructions from the Game menu.

Again, we’ve come to the end of a section.  Now, you can create a game, 

import all the information, look at it in many different ways, 

create/check/export/distribute your orders. You can draw them on the map (!), 

export a map jpg for your less technical allies, and even import their orders to 

cross-check and reconcile the coming turn.  But as you might expect, that is far 

from the limit of this program.  Next section, I’ll work through the various 

Economic tabs – the Economy is considered amongst the most important 

aspects of the game, no..?



Economy Calc

There is simply too much here to go over without killing too many trees in order to do a

“complete” job.  Take a look at everything here.

While your order Costs are calculated automatically, you do have to manually enter your

Buys and Sells in this section.  When you do, and click on the Update button to ensure your

order Costs are calculated,  you’ll see the results of your turn.  Toggle your Pops that you

expect to Lose in combat to ensure accuracy.

Personally, I rely exclusively on this tool to ensure I don’t die the unexpected death....  After

I’ve done all my extraneous orders, I usually click on my Capital to show all those characters

in Current Hex View, and then switch to the Economy Calc pane in order to ensure I’m

issuing the buys/sells necessary to maintain my nation.

As you might expect, in Current Hex View, Population Centre section, you can also Toggle

Expected to be Lost.  This information will then carry forward to the Economy Calc pane.

As you might expect, in the Orders pane, you can see the cost of the orders you’ve entered.



Team Economy

Again, it’s virtually impossible

to go over everything in here,

but at least this is simply data

and I’m not glossing over

important functionality...

Notice how my Economy Calc

information was brought over.

Again, for fun with statistics, every table displayed here except the first one

can be sorted by each column!



Miscellaneous Tabs

Now I’m going to go over a few things until my laptop battery dies... I don’t use everything in here,

and with the variation in players styles, I’m sure many will use what I don’t, and vice versa...

I’m sure you can see the value in this particular tab~!  Note, Drag and Drop functionality works

here also, excepting where the Character Names have funky accents and things.  From the

Tools menu, go to Preferences and then Display – Information Tabs to adjust the Track

Character Names option from ascii to Accented and back again.  ascii for when you type the

name in yourself, Accented for when you Drag and Drop Urzahil there...



No more spreadsheets or hunting through pdfs~!

Very quickly – who can Company Up..?

Who’s already done so and where the heck are they??



Hey, why not just track everyone at once...! This pane shows all

rumors for enemy actions (e.g. thefts, sabotages, etc) so you can keep

track of enemy characters.

Choose your spell List filter and Double Click to find what you need

Here is where you can switch from every nation

having their own colour to the Blue/Red/Green

colours based on Allegiance.

You can also choose any of the other options for 

the map, namely to show pop center names,

to show the climate for known hexes, to change 

the zoom level, etc.

Note, in the Tools menu, you can select the

Palantir Map Style if you prefer, which will set 

the preferences so that the map resembles that

of Palantir.



Customization

I will not tell a lie – it’s apparently quite tricky to put together a multi-window style program

(multiple quadrants) in your spare time where most people criticize because it isn’t the way

they would do it and nobody is paying you...  So customizing the program is neither the most

intuitive nor easiest exercise in the world..  But it can be done!

JOverseer is set up with a default quadrant structure showing default tabs of information.  The

set up that I’ve been using in this Guide is not the default.  I’ve customized it quite a bit, and,

to be honest, I wasn’t willing to re-install for illustrative purposes for this guide as I’d have to 

put everything back the way I like it..and as I’ve said, it’s not easy! But it’s worth hacking with 

until you get your information the way you want it.

Step 1 – from the Window menu option illustrated below, choose the tabs you would like to 

use in your program.  Watch where they end up when you do so..  The Active Quadrant is

highlighted as a Darker shade of grey than the others – this is where your new tab will appear.

Active Quadrant – Dark Grey

Step 2 – Delete Tabs!  Right Click on a highlighted tab and choose Close

Step 3 – Move Tabs around

This is tricky and has the potential to cause great distress.  Please do not

take it out on the computer.  You will have to grab tabs and move them

around on your own for a while to see how they work.  You can always

close them all off if you need to...

Double Clicking on a tab will Maximize it – double click again to put it back~!


